Difficulty Scale      (really easy)
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Statistics or Sadistics?
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WHY STATISTICS?
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✦✦ How to succeed in this course
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WHAT YOU’LL LEARN ABOUT IN THIS CHAPTER
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You’ve heard it all before, right? “Statistics is difficult,” “The math
involved is impossible,” “I don’t know how to use a computer,”
“What do I need this stuff for?” “What do I do next?” and the
famous cry of the introductory statistics student, “I don’t get it!”
Well, relax. Students who study introductory statistics find themselves, at one time or another, thinking at least one of the above and
quite possibly sharing the thought with another student, their
spouse, a colleague, or a friend.
And all kidding aside, some statistics courses can easily be
described as sadistics. That’s because the books are repetitiously
boring and the authors have no imagination.
That’s not the case for you. The fact that you or your instructor
has selected Statistics for People Who (Think They) Hate Statistics,
Excel 2016 Edition shows that you’re ready to take the right
approach—one that is unintimidating, informative, and applied
(and even a little fun) and that tries to teach you what you need to
know about using statistics as the valuable tool that it is.
5
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If you’re using this book in a class, it also means that your
instructor is clearly on your side. He or she knows that statistics
can be intimidating but has taken steps to see that it is not intimidating for you. As a matter of fact, we’ll bet there’s a good chance
(as hard as it may be to believe) that you’ll be enjoying this class in
just a few short weeks.

And Why Excel?
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Simple. It’s the most popular, most powerful spreadsheet tool available today, and it can be an exceedingly important and valuable tool
for learning how to use basic and some advanced statistics. In fact,
many stats courses taught at the introductory level use Excel as their
primary computational tool and ignore other computer programs,
such as IBM® SPSS® Statistics (SPSS)* and Minitab. Although we are
not going to teach you how to use Excel (see Appendix A for a
refresher on some basic tasks), we will show you how to use it to
make your statistics learning experience a better one.
But like any program that takes numbers and consolidates and
analyzes them, Excel is not a magic bullet or a tool to solve all your
problems. It has its limitations. Unless you are an expert programmer and you can program Excel to do just about anything other
statistics programs can (the language you would use is Visual Basic
Applications or VBA), Excel may not look as pretty as other programs dedicated to statistical analysis or offer as many options. But
at the level of introductory statistics, it is a very powerful tool that
can do an awful lot of very neat things.
A bit of terminology about Excel before we move on: The first ever
Excel-like computer application was called VisiCalc (thank you, Dan
Bricklin and Bob Frankston) and was known as a spreadsheet. Okay,
the Excel application is known as a spreadsheet program as well, but
each individual sheet is known as a worksheet. And worksheets,
when combined, constitute what is known as a workbook. Fun, huh?

D

o

A 5-MINUTE HISTORY OF STATISTICS
Before you read any further, it would be useful to have some historical perspective about this topic called statistics. After all,
almost every undergraduate in the social, behavioral, and biological
sciences and every graduate student in education, nursing,
*SPSS is a registered trademark of International Business Machines Corporation.
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psychology, social welfare and social services, anthropology, and . . .
(you get the picture) is required to take this course. Wouldn’t it be
nice to have some idea from whence the topic it covers came? Of
course it would.
Way, way back, as soon as humans realized that counting was a
good idea (as in “How many of these do you need to trade for one
of those?”), collecting information became a useful skill.
If counting counted, then one would know how many times the
sun would rise in one season, how much food was needed to last
the winter, and what amount of resources belonged to whom.
That was just the beginning. Once numbers became part of language, it seemed like the next step was to attach these numbers to
outcomes. That started in earnest during the 17th century, when the
first set of data pertaining to populations was collected. From that
point on, scientists (mostly mathematicians, but then physical and
biological scientists) needed to develop specific tools to answer
specific questions. For example, Francis Galton (a half-cousin of
Charles Darwin, by the way), who lived from 1822 to 1911, was
very interested in the nature of human intelligence. He also speculated that hair loss was due to the intense energy that went into
thinking. No, really. But back to statistics.
To explore one of his primary questions regarding the similarity
of intelligence among family members, he used a specific statistical
tool called the correlation coefficient (first developed by mathematicians), and then he popularized its use in the behavioral and social
sciences.
You’ll learn all about this tool in Chapter 5. In fact, most of the
basic statistical procedures that you will learn about were first
developed and used in the fields of agriculture, astronomy, and even
politics. Their application to human behavior came much later.
The past 100 years have seen great strides in the invention of new
ways to use old ideas. The simplest test for examining the differences between the averages of two groups was first advanced during
the early 20th century. Techniques that build on this idea were
offered decades later and have been greatly refined. And the introduction of personal computers and such programs as Excel has
opened up the use of sophisticated techniques to anyone who wants
to explore these fascinating topics.
The introduction of these powerful personal computers has been
both good and bad. It’s good because most statistical analyses no
longer require access to a huge and expensive mainframe computer.
Instead, a simple personal computer costing less than $250 or a
cloud account can do 95% of what 95% of the people need. On the

e
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other hand, less than adequately educated students (such as your
fellow students who passed on taking this course!) will take any old
data they have and think that by running them through some
sophisticated analysis, they will have reliable, trustworthy, and
meaningful outcomes—not true. What your professor would say is
“Garbage in, garbage out”; if you don’t start with reliable and trustworthy data, what you’ll have after your data are analyzed are unreliable and untrustworthy results.
Today, statisticians in all different areas, from criminal justice to
geophysics to psychology, find themselves using basically the same
techniques to answer different questions. There are, of course,
important differences in how data are collected, but for the most
part, the analyses (the plural of analysis) that are done following the
collection of data (the plural of datum) tend to be very similar, even
if called something different. The moral here? This class will provide
you with the tools to understand how statistics are used in almost
any discipline. Pretty neat, and all for just three or four credits.
If you want to learn more about the history of statistics and see
a historical time line, great places to start are Saint Anselm’s
College at www.anselm.edu/homepage/jpitocch/biostatshist.html
and the University of California–Los Angeles at www.stat.ucla
.edu/history/.
Okay. Five minutes is up, and you know as much as you need
to know about the history of statistics. Let’s move on to what it is
(and isn’t).

STATISTICS: WHAT IT IS (AND ISN’T)
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Statistics for People Who (Think They) Hate Statistics, Excel 2016
Edition is a book about basic statistics and how to apply them to a
variety of different situations, including the analysis and understanding of information.
In the most general sense, statistics describes a set of tools and
techniques that are used for describing, organizing, and interpreting information or data. Those data might be the scores on a test
taken by students participating in a special math curriculum, the
speed with which problems are solved, the number of side effects
when patients use one type of drug rather than another, the number of errors in each inning of a World Series game, or the average
price of a dinner in an upscale restaurant in Santa Fe, New Mexico
(not cheap).
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In all of these examples, and the million more we could think of,
data are collected, organized, summarized, and then interpreted. In
this book, you’ll learn about collecting, organizing, and summarizing data as part of descriptive statistics. And then you’ll learn about
interpreting data when you learn about the usefulness of inferential
statistics.
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Descriptive statistics are used to organize and describe the characteristics of a collection of data. The collection is sometimes called a
data set or just data.
For example, the following list shows you the names of 22 college students, their major areas of study, and their ages. If you
needed to describe what the most popular college major is, you
could use a descriptive statistic that summarizes their most frequent
choice (called the mode). In this case, the most common major is
psychology. And if you wanted to know the average age, you could
easily compute another descriptive statistic that identifies this variable (that one’s called the mean). Both of these simple descriptive
statistics are used to describe data. They do a fine job of allowing us
to represent the characteristics of a large collection of data such as
the 22 cases in our example.
Name

Major

Name

Major

Age

Education

19

Elizabeth

English

21

Sara

Psychology

18

Bill

Psychology

22

Andrea

Education

19

Hadley

Psychology

23

Steven

Psychology

21

Buffy

Education

21

Jordan

Education

20

Chip

Education

19

Pam

Education

24

Homer

Psychology

18

Michael

Psychology

21

Margaret

English

22

Liz

Psychology

19

Courtney

Psychology

24

Nicole

Chemistry

19

Leonard

Psychology

21

Mike

Nursing

20

Jeffrey

Chemistry

18

Kent

History

18

Emily

Spanish

19
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Richard
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Age
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So watch how simple this is. To find the most frequently selected
major, just find the one that occurs most often. And to find the
average age, just add up all the age values and divide by 22. You’re
right—the most often occurring major is psychology (9 times), and
the average age is 20.3 (actually 20.27). Look, Ma! No hands—
you’re a statistician.
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Inferential statistics are often (but not always) the next step after
you have collected and summarized data. Inferential statistics are
used to make inferences based on a smaller group of data (such as
our group of 22 students) about a possibly larger one (such as all
the undergraduate students in the College of Arts and Sciences).
A smaller group of data is often called a sample, which is a portion, or a subset, of a population. For example, all the fifth graders
in Newark (your author’s fair city of origin), New Jersey, would be
a population (the population is all the occurrences with certain
characteristics, in this case, being in fifth grade and attending
school in Newark), whereas a selection of 150 of these students
would be a sample.
Let’s look at another example. Your marketing agency asks you
(a newly hired researcher) to determine which of several names
is most appealing for a new brand of potato chip. Will it be
Chipsters? FunChips? Crunchies? As a statistics pro (we know
we’re moving a bit ahead of ourselves, but keep the faith), you
need to find a small group of potato chip eaters who are representative of all potato chip fans and ask these people to tell you which
one of the three names they like the most. Then, if you do things
right, you can easily extrapolate the findings to the huge group of
potato chip eaters.
Or let’s say you’re interested in the best treatment for a particular
type of disease. Perhaps you’ll try a new drug as one alternative, a
placebo (a substance that is known not to have any effect) as
another alternative, and nothing as the third alternative to see what
happens. Well, you find out that more patients get better when no
action is taken and nature (and we assume that’s the only factor or
set of factors that differentiate the groups) just takes its course! The
drug does not have any effect. Then, with that information, you can
extrapolate to the larger group of patients who suffer from the disease, given the results of your experiment.
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Statistics is a tool that helps us understand the world around us. It
does so by organizing information we’ve collected and then letting
us make certain statements about how characteristics of those data
are applicable to new settings. Descriptive and inferential statistics
work hand in hand, and which statistic you use and when depends
on the question you want answered.
And today, a knowledge of statistics is more important than ever
because it provides us with the tools to make decisions that are
based on empirical (observed) evidence and not our own biases or
beliefs. Want to know whether early intervention programs work?
Then test whether they work and provide that evidence to the court
where a ruling will be made on the viability of a new school bond
issue that could pay for those programs.
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In Other Words . . .
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TOOLING AROUND WITH
THE DATA ANALYSIS TOOLS

D

o

no
t

co
py
,

An awful lot of what you need to know about using Excel can be
found in Appendix A. However, certain Excel procedures are available only if you have the Data Analysis tools installed (and we use
those tools in several chapters throughout the book). Please note
that this Excel add-in is sometimes called the Data Analysis Toolpak
and sometimes the Data Analysis tool or Data Analysis tools and
sometimes the Analysis Toolpak. These are all different names for
the same thing. We’ll refer to it as Data Analysis tools to cover all
the bases.
The Data Analysis tools are a spectacular Excel add-in. Add-ins
are special sets of tools that are often not installed when Excel was
originally installed.
How do you know whether Data Analysis tools are installed on
the computer you are using? If the Data Analysis tools option
doesn’t appear on your Data tab as Data Analysis tools (as you see
it appears in Figure 1.1) in the Windows version, you need to install
it. Either ask your instructor to have it installed on the network
level where Excel is installed or install it on your own machine by
doing the following. In the Mac version, it appears as the Data
Analysis option on the Tools menu, so Mac users have no need for
any installation steps.
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1. Click the File tab and then click Options.
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The Data Analysis Tools Option on the Data Tab
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Figure 1.1

2. Click Add-Ins and then in the Add-Ins box, select Analysis
Toolpak (see, it’s named different things in different places).
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3. Click Go under Manage, at the bottom of the screen.
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4. In the Add-Ins box, click the Analysis Toolpak check box and
then click OK.
You are now ready to make your Excel activities even that much
more productive and fun. You can learn how to use the Data Analysis tools in Little Chapter 1b.
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WHAT AM I DOING IN
A STATISTICS CLASS?
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You might find yourself using this book for many reasons. You
might be enrolled in an introductory statistics class. Or you might
be reviewing for your comprehensive exams. Or you might even be
reading this on summer vacation (horrors!) in preparation for a
more advanced class.
In any case, you are a statistics student, whether you have to take
a final exam at the end of a formal course or you’re just in it of your
own accord. But there are plenty of good reasons to be studying this
material—some fun, some serious, and some both.
Here’s the list of some of the things that my students hear at the
beginning of our introductory statistics course:
1. Statistics 101 or Statistics 1 or whatever it’s called at your
school looks great listed on your transcript. Kidding aside,
this may be a required course for you to complete your
major. But even if it is not, having these skills is definitely a
big plus when it comes time to apply for a job or for further
schooling. And with more advanced courses, your résumé
will be even more impressive.
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2. If this is not a required course, taking basic statistics sets you
apart from those who do not. It shows that you are willing
to undertake a course that is above average with regard to
difficulty and commitment. And, as the political and economic (and sports!) worlds become more “accountable,”
more emphasis is being placed on analytic skills. Who
knows, this course may be your ticket to a job!
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3. Basic statistics is an intellectual challenge of a kind that
you might not be used to. There’s a good deal of thinking
that’s required, a bit of math, and some integration of
ideas and application. The bottom line is that all this
activity adds up to what can be an invigorating intellectual experience because you learn about a whole new area
or discipline.
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4. There’s no question that having some background in statistics makes you a better student in the social or behavioral sciences, because you will have a better understanding
not only of what you read in journals but also of what
your professors and colleagues may be discussing and
doing in and out of class. You will be amazed the first time
you say to yourself, “Wow, I actually understand what
they’re talking about.” And it will happen over and over
again, because you will have the basic tools necessary to
understand exactly how scientists reach the conclusions
they do.
5. If you plan to pursue a graduate degree in education,
anthropology, economics, nursing, sociology, or any one of
many other social, behavioral, and biological pursuits, this
course will give you the foundation you need to move
further.
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6. There are many different ways of thinking about, and
approaching, different types of problems. The set of tools
you learn about in this book (and this course) will help you
look at interesting problems from a new perspective. And,
while not apparent now, this new way of thinking can be
brought to new situations.
7. Finally, you can brag that you completed a course that everyone thinks is the equivalent of building and running a
nuclear reactor.
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TEN WAYS TO USE THIS BOOK (AND
LEARN STATISTICS AT THE SAME TIME!)
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Yep. Just what the world needs—another statistics book. But this one is different. It
is directed at the student, is not condescending, is informative, and is as basic as
possible in its presentation. It makes no presumptions about what you should know
before you start and proceeds in slow, small steps, which lets you pace yourself.
However, there has always been a general aura surrounding the study of statistics
that it’s a difficult subject to master. And we don’t say otherwise, because parts of it
are challenging. On the other hand, millions and millions of students have mastered
this topic, and you can, too. Here are 10 hints to close this introductory chapter
before we move on to our first topic.
1. You’re not dumb. That’s true. If you were, you would not have gotten this
far in school. So, treat statistics as you would any other new course. Attend
the lectures, study the material, do the exercises in the book and from class,
and you’ll do fine. Rocket scientists know statistics, but you don’t have to be
a rocket scientist to succeed in statistics.
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2. How do you know statistics is hard? Is statistics difficult? Yes and no. If you
listen to friends who have taken the course and didn’t work hard and didn’t
do well, they’ll surely volunteer to tell you how hard it was and how much
of a disaster it made of their entire semester, if not their lives. And let’s not
forget—we always tend to hear from complainers. So, we’d suggest that you
start this course with the attitude that you’ll wait and see how it is and judge
the experience for yourself. Better yet, talk to several people who have had
the class and get a good idea of what they think. Don’t base your expectations on just one spoilsport’s experience.
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3. Don’t skip lessons—work through the chapters in sequence. Statistics for
People Who (Think They) Hate Statistics, Excel 2016 Edition is written so that
each chapter provides a foundation for the next one in the book. When you
are all done with the course, you will (I hope) continue to use this book as a
reference. So if you need a particular value from a table, you might consult
Appendix B. Or if you need to remember how to compute the standard deviation, you might turn to Chapter 3. But for now, read each chapter in the
sequence that it appears. It’s okay to skip around and see what’s offered down
the road. Just don’t study later chapters before you master earlier ones.
4. Form a study group. This is a big hint and one of the most basic ways to
ensure some success in this course. Early in the semester, arrange to study
with friends or classmates. If you don’t have any friends who are in the same
class as you, then make some new ones or offer to study with someone who
looks as happy to be there as you are. Studying with others allows you to
help them if you know the material better, or to benefit from those who
know some material better than you. Set a specific time each week to get
together for an hour and go over the exercises at the end of the chapter or
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ask questions of one another. Take as much time as you need. Studying with
others is an invaluable way to help you understand and master the material
in this course.
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5. Ask your teacher questions, and then ask a friend. If you do not understand
what you are being taught in class, ask your professor to clarify it. Have no
doubt—if you don’t understand the material, then you can be sure that others
do not as well. More often than not, instructors welcome questions. And especially because you’ve read the material before class, your questions should be
well informed and help everyone in class to better understand the material.
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6. Do the exercises at the end of the chapters. The exercises are based on the
material and the examples in the chapter they follow. They are there to help
you apply the concepts that were taught in the chapter and build your confidence at the same time. If you can answer these end-of-chapter exercises,
then you are well on your way to mastering the content of the chapter.
Correct answers to each exercise are provided in Appendix D.
7. Practice, practice, practice. Yes, it’s a very old joke:
Q. How do you get to Carnegie Hall?
A. Practice, practice, practice.
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Well, it’s no different with basic statistics. You have to use what you learn
and use it frequently to master the different ideas and techniques. This
means doing the exercises in the back of Chapters 1 through 17 and Chapter
20 as well as taking advantage of any other opportunities you have to understand what you have learned.
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8. Look for applications to make it more real. In your other classes, you probably have occasion to read journal articles, talk about the results of research,
and generally discuss the importance of the scientific method in your own
area of study. These are all opportunities to see how your study of statistics
can help you better understand the topics under class discussion as well as
the area of beginning statistics. The more you apply these new ideas, the
fuller your understanding will be.
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9. Browse. Read over the assigned chapter first; then go back and read it with
more intention. Take a nice leisurely tour of Statistics for People Who (Think
They) Hate Statistics to see what’s contained in the various chapters. Don’t
rush yourself. It’s always good to know what topics lie ahead as well as to
familiarize yourself with the content that will be covered in your current
statistics class.
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10. Have fun. This might seem like a strange thing to say, but it all boils down
to you mastering this topic rather than letting the course and its demands
master you. Set up a study schedule and follow it, ask questions in class,
and consider this intellectual exercise to be one of growth. Mastering new
material is always exciting and satisfying—it’s part of the human spirit. You
can experience the same satisfaction here—just keep your eye on the ball
and make the necessary commitment to stay current with the assignments
and work hard.
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And a short note for Mac users. Over the years, the Excel people
at Microsoft have become increasingly kind to users of the Macintosh version. The latest versions of Excel for a Windows operating system and a Macintosh operating system are almost identical.
And, as we have mentioned before, for the first time in the history
of the galaxy, the Mac version now comes with the Data Analysis
tools, the great convenience that the Windows version has provided
for years.
One big difference between the Windows and the Mac version
(and it really isn’t that big) is the keystrokes that one uses to
accomplish particular tasks. So, for example, instead of using the
Ctrl+C key combination in Windows to copy highlighted text
windows, the Mac uses the Apple or the Command key (the cool
little key on the lower left of the keyboard with the four little
squiggles) in combination with the C key to accomplish the same.
This Apple key is also referred to (believe it or not) as the splat,
the cloverleaf, the butterfly, the beanie, or the flower key. Using
Excel in one operating system or the other (or both) requires a
very similar set of tasks, and you should have no problem making
the adjustment.
Plus, both the Windows and the Mac version of Excel can read
each other’s files, so you are safe exchanging files between one operating system and the other. All that said, if they really want to
impress their friends, Mac users can go to System Preferences and
reconfigure the keyboard to ensure that Windows and Mac keystrokes are exactly the same!

+ ICONS
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An icon is a symbol. Throughout Statistics for People . . . , you’ll
see a variety of icons. Here’s what each one is and what each
represents:
This icon represents information that goes beyond the regular
text. At times we may want to elaborate on a particular point and
find we can do so more easily outside of the flow of the usual
material.
Here, we discuss some more technical ideas and tips to give you
a sampling of topics beyond the scope of this course. You might
find these interesting and useful.
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That finger with the bow is a cute icon, but its primary purpose
is to help reinforce important points about the topic that you just
read about. Try to emphasize these points in your studying,
because they are usually central to the topic.

e

Throughout Statistics for People . . . , you’ll find a small-steps icon
like the one you see here. This indicates that a set of steps is coming up that will direct you through a particular process. These
steps have been tested and approved by whatever federal agency
approves these things.
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Many of the chapters in Statistics for People . . . provide detailed
information about one or more statistical procedures and the
computation that accompanies them. The computer icon is used
to identify the “Using the Amazing Data Analysis Tools to . . .”
section of the chapter.
The more Excel icon identifies additional information on the Excel
feature that has just been mentioned or worked with in the text.
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Appendix A, Excel-erate Your Learning: All You Need to Know
About Excel, contains a collection of 50 basic and important (and
time-saving) tasks that anyone who uses Excel should know.
Appendix B contains important tables you will learn about and
need throughout the book.
And, in working through the exercises in this book, you will use
the data sets in Appendix C. In the exercises, you’ll find references
to data sets with names like “Chapter 2 Data Set 1,” and each of
these sets is shown in Appendix C. You can either enter the data
manually or download them from the publisher’s site at http://edge
.sagepub.com/salkindexcel4e or get them directly from the author.
Just send a note to njs@ku.edu and don’t forget to mention the edition for which you need the data sets.
Appendix D contains answers to end-of-chapter questions,
Appendix E contains a primer on math for those who could use a
refresher, and Appendix F offers the long-sought-after brownie
recipe.

KEY TO DIFFICULTY ICONS
To help you along a bit, we placed a difficulty index at the beginning
of each chapter. This adds some fun to the start of each chapter, but
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it’s also a useful tip to let you know what’s coming and how difficult
chapters are in relation to one another.
 (very hard)

    (easy)
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     (very easy)

rib
ut

   (not too hard, but not easy either)

e

  (hard)
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KEY TO “HOW MUCH EXCEL” ICONS

To help you along a bit more, we placed a “How Much Excel” index
at the beginning of each chapter. This adds even more fun (groan)
to the start of each chapter, but it also lets you know how much
Excel material is contained in the chapter.
How much Excel?

po
s

(just a mention)
(some)

(lots)

co
py
,

(lots and lots)
(a ton)

no
t

GLOSSARY

Bolded terms in the text are included in the glossary at the back of
the book.
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SUMMARY
That couldn’t have been that bad, right? We want to encourage you to
continue reading and not worry about what’s difficult or time-consuming
or too complex for you to understand and apply. Just take one chapter at
a time, as you did this one.
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rib
ut

Because there’s no substitute for the real thing, Chapters 1 through 17
and Chapter 20 each end with a set of exercises that will help you
review the material that was covered in the chapter. As noted above, the
answers to these exercises can be found near the end of the book in
Appendix D.
For example, here is the first set of exercises (but don’t look for any
answers for these because these are kind of “on your own” answers—
each answer is highly tied to your own experiences and interest).

e

TIME TO PRACTICE

t,
or
d

is
t

1. Interview someone who uses statistics in his or her everyday
work. It might be your adviser, an instructor, a researcher who
lives on your block, a market analyst for a company, a city planner, or . . . Ask the person what his or her first statistics course
was like. Find out what the person liked and didn’t like. See if
this individual has any suggestions to help you succeed. And
most important, ask the person about how he or she uses these
new-to-you tools at work.

co
py
,

po
s

2. We hope that you are part of a study group or, if that is not possible, that you have a telephone, e-mail, instant messaging, or webcam study buddy (or even more than one). And, of course, plenty
of Facebook friends. Talk to your group or a fellow student in your
class about similar likes, dislikes, fears, etc. about the statistics
course. What do you have in common? Not in common? Discuss
with your fellow student strategies to overcome your fears.

no
t

3. Search through your local newspaper (or any other publication)
and find the results of a survey or interview about any topic.
Summarize the results and do the best job you can describing
how the researchers who were involved, or the authors of the
survey, came to the conclusions they did. Their methods and reasoning may or may not be apparent. Once you have some idea of
what they did, try to speculate as to what other ways the same
information might be collected, organized, and summarized.

D
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4. Go to the library (either in person or online) and find a copy of
a journal article in your own discipline. Then, go through the
article and highlight the section (usually the “Results” section)
where statistical procedures were used to organize and analyze
the data. You don’t know much about the specifics of this yet,
but how many different statistical procedures (such as t-test,
mean, and calculation of the standard deviation) can you identify? Can you take the next step and tell your instructor how the
results relate to the research question or the primary topic of the
research study?

Copyright ©2017 by SAGE Publications, Inc.
This work may not be reproduced or distributed in any form or by any means without express written permission of the publisher.

Part I ♦ Yippee! I’m in Statistics

20

e

5. Find five websites that contain data on any topic and write a
brief description of what type of information is offered and how
it is organized. For example, if you go to the mother of all data
sites, the US Census (www.census.gov), you’ll find links to hundreds of databases, tables, and other informative tools. Try to
find data and information that fit in your own discipline.

is
t
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6. And the big extra-credit assignment is to find someone who
actually uses Excel for daily data analysis needs. Ask why he or
she uses Excel rather than a more specialized program such as
SPSS or Minitab. Also, ask if there is anything specific about
Excel that makes it stand out as a tool for data analysis. You may
very well find these good folks in everything from political science to nursing, so search widely!
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7. Finally, as your last in this first set of exercises, come up with
five of the most interesting questions you can about your own
area of study or interest. Do your best to come up with questions
for which you would want real, existing information or data to
answer. Be a scientist!
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All You Need to Know
About Formulas and
Functions
Difficulty Scale   (a little tough,
but invaluable to stick with)
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(lots and lots)
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How much Excel?

WHAT YOU’LL LEARN ABOUT IN THIS CHAPTER

po
s

✦✦ The difference between formulas and functions
✦✦ How to create and use a formula
✦✦ The important Excel functions

co
py
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✦✦ How to select and use a function

T

no
t

here may be nothing more valuable in your Excel magic
tool box than formulas and functions. They both allow you
to bypass (very) tedious calculations and get right to the
heart of the matter. Both formulas and functions are shortcuts—
and both work in different ways and do different things. Let’s start
with formulas.

D
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WHAT’S A FORMULA?

You probably already know the answer to that question. A formula
is a set of mathematical operators that performs a particular mathematical task. For example, here’s a simple formula:
2+2=

21
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The operator + tells you to add certain values (a 2 and another 2)
together to produce the outcome (4). This is a simple one.
Here’s one that’s a bit more advanced and one with which you will
become more familiar in Chapter 16 of Statistics for People . . . :
Y = bX + a

rib
ut

e

(1A.1)

Creating a Formula

t,
or
d
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This is the formula that is used to predict the value of Y' from our
knowledge of the values of b, X, and a. We’ll worry about what all
those symbols mean later. For now, just know this is a formula that
contains a bunch of symbols and mathematical operators and helps
us compute numbers we need to make decisions.
Excel is a formula engine just ready to help make your learning
of statistics easier.

A formula is created through these steps:

po
s

1. Click on the cell in which you want the results of the formula to appear.
2. Enter an equal sign, which looks like this: =. All formulas
begin with an equal sign, no matter what else they contain.

co
py
,

3. Enter the formula. No spaces in formulas please—Excel
does not like them.
4. Press the Enter key, and voilà! The results of the formula will
appear in the selected cell.

no
t

For example, let’s enter the formula that was shown earlier— 2
+ 2—and see how these steps work.
As you can see in Figure 1A.1, we selected Cell A1.
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Figure 1A.1 Selecting a Cell Into Which a Formula Will Be Entered
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Entering the Equal Sign to Indicate the Beginning of
a Formula
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Figure 1A.2

rib
ut

1. The equal sign is entered, as shown in Figure 1A.2. And, as
you can see, the formula bar at the top of the column
becomes active. Everything we enter in Cell A1 will appear
in the formula bar. Also, note that Excel automatically enters
the name of the last function used (in this example it is
AVERAGE—much more about functions soon).
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2. Enter the rest of the formula, which in this case is (2+4)/2,
as you see in Figure 1A.3.

co
py
,

po
s

Figure 1A.3 Entering the Formula in Cell A1

no
t

3. Press Enter, and the value of the formula is returned to the
cell, as you see in Figure 1A.4. And, if you click on cell A1
(as we did in Figure 1A.4), you can see the formula located
in that cell. In all cases, when a formula is entered into a cell,
you see the results of that formula in the cell and the formula
itself in the formula bar. In this case, the formula (2+4)/2
(shown in the formula bar) returns the result of 3.
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Figure 1A.4 The Value of a Formula Being Returned to the Cell
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A few notes:

rib
ut

e

•• A formula always begins with an equal sign, which tells Excel
that what follows is the formula.
•• The formula itself always appears in the formula bar.
•• The results of the formula (and not the formula itself) are
returned to the selected cell.

is
t

This is the simplest example of how to use a formula. Formulas
can become as complex as you need them to be.
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Want to see the formula behind the scenes in a worksheet? Just use the
Ctrl+` key combination to toggle between formulas and the results of
those formulas. The ` key is to the left of the number 1 key near the top
of the keyboard.

Operator, Operator—Get Me a Formula!

co
py
,

po
s

You have just seen that even the simplest formulas consist of operators. In this case, the only operators are a plus (+) sign and a division (/) sign, which direct Excel to add the two values you see in
Figure 1A.3, divide by 2, and return the sum to Cell A1.
Addition and division are just two of the operations you can perform. The most important operations and the symbols you use to
accomplish them are shown in the following table.
Operator

Example

What It Does

+ (plus)

=2+5

Adds 2 and 5.

Subtraction

– (minus)

=5–3

Subtracts 3 from 5.

Division

/ (slash)

=10/5

Divides 10 by 5.

Multiplication

* (asterisk)

=2*5

Multiplies 2 times 5.

Power of

^ (caret)

=4^2

Takes 4 to the power of 2,
or squares 4.

no
t

Addition

D
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Symbol

Beware the Parentheses
When you create a formula that goes beyond a very simple one, it
is critical for you to consider the order in which operations are carried out and the use of parentheses.
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Let’s say that we want to find the average score on a weekly test
given each Friday for a month and the scores range from 0 to 100.
Here are Willy’s scores:
78

Week 2

56

Week 3

85

Week 4

92 (Willy finally got it!)

rib
ut

e

Week 1

is
t

We need to create a formula that will add all of the scores together
and divide the sum by 4. We’ll name the scores w1, w2, w3, and w4.
Here’s one way we might try it:
w1 + w2 + w3 + w4 /4

t,
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Oops! This will work in the sense that it will produce a number, but it won’t give you the outcome you want. What this does is
add w1, w2, and w3 together and then adds that sum to the value of
(only) w4 divided by 4. This is not what we want.
Rather, take a look at this formula:

po
s

(w1 + w2 + w3 + w4)/4

co
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This is more like it. Here, the four values are summed and then
that sum is divided by 4. This one works. The lesson? Watch your
parentheses!

WHAT’S A FUNCTION?

D
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You know that a formula is a simple set of symbols (such as numbers and operators) that performs some calculation and results in an
outcome in the cell where the formula lives.
A function is nothing other than a predefined formula. The good
people who created Excel developed a whole bunch of functions
that can do many different things, but throughout Statistics for
People . . . , we deal only with those that are relevant to the things
we do in these chapters. Functions fall under the general Formulas
tab on the ribbon, as you see in Figure 1A.5.
Figure 1A.5 The Formulas Tab on the Excel Ribbon
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e

For example, there are groups of financial functions, logical
functions, text functions, and others. But we’re going to focus
(mostly) on the functions that fall in the category of statistical
functions and a few database functions. The group of statistical
functions are visible on your screen only when you click on the
More Functions drop-down box, which you see in Figure 1A.5,
and then click Statistical. The group of database functions must be
the black sheep of Excel because they don’t have their own grouping on the Excel Ribbon. Instead, you have to click the Insert
Function button on the left of the ribbon and then specify the
group of database functions.
Functions that are relevant to the material covered in this book
include AVERAGE (guess what that does) and T.TEST (guess, but
you probably don’t yet know). Some are too advanced for us to
bother with, such as FISHER and GAMALIN. We’ll leave those for
the next course or for you to explore on your own.

Using a Function

=AVERAGE(A1:A3)

D
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Unlike a formula, a function is not created by you. You just tell it
which values (located in which cells) you want to work with. Every
formula contains two elements—the name of the function and the
argument of the function. Argument doesn’t mean the function is
quarrelling over whose turn it is to wash the dishes. To understand
what an Excel argument is, let’s look at an example.
Here’s a very simple function that averages a given set of numbers. In this example, this function averages the numbers in Cells
A1 through A3:

The name of the function is AVERAGE, and the argument is
A1:A3—the cells on which you want the function to perform its
magic. And as you can see, functions (like formulas) always, always, always begin with an equal sign.
Here’s another function that produces the sum of a set of cells:
=SUM(A1:A3)

Simple, right? And, you may be thinking, “Well, why not just use
a formula in this case?” and you could. But what if you need the
sum of a set of 3,267 values like this?
=SUM(A1:A3267)
Copyright ©2017 by SAGE Publications, Inc.
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You really don’t want to type in =(A1+A2+A3+A4 . . .) until
you get to A3267, right? We thought not. Or what if you need a
fancy-schmancy calculation that includes formulas that are very
complex? Functions to the rescue!
So, let’s get to the way that we use a function, and as an example,
we’ll use the AVERAGE function.
To use this (or any other function), you follow three steps:

27
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1. Enter the function in the cell where you want the results to
appear.

is
t

2. Enter the range of cells on which you want the function to
operate.
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3. Press the Enter key, and voilà! There you have the result
located in the cell in which the function was created.
However, there are several ways to accomplish these three steps,
and let’s deal with those now.

Inserting a Function (When You Know
the Function’s Name and How It Works)

po
s

Here’s the old-fashioned way.

1. Enter the function in the cell where you want the results to
appear.

co
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,

For example, in Figure 1A.6, you can see a data set of 10 values.
We are going to find the average of those values using the AVERAGE function. And, to make things a bit clearer, we entered a text
label in the cell to the left of where we want the sum to appear.
Creating a Data Set and the Location of the AVERAGE
Function

D
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Figure 1A.6
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2. Type =AVERAGE(B2:B11) in Cell B12.

e

3. Press the Enter key, and presto: As you see in Figure 1A.7,
the sum shows up in Cell B12, and in the formula bar, you
can see the structure of the function.
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t
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Notice that the results of the function (3.3) are returned to the
same cell (B12) where the function was entered. Pretty cool.
And not very difficult. And very convenient. Remember that you
can do this with any function. But how do you know what the structure of the function is? That’s where the next step comes in.
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Figure 1A.7 The Completed AVERAGE Function

Okay—so how do you know what function to use? Well, certainly one
way is through exploring different functions and finding out what they
do (which you will do throughout Statistics for People . . .). Another is by
using Excel Help (press F1 at any time and enter the terms on which you
want help). And another way is to look at Table 1A.1 at the end of this
little chapter, which gives you a heads-up on which functions we’ll be
mentioning (some in great detail and others just in passing) throughout
the book and what they do.
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Let’s use the same example, the AVERAGE function, and assume
you haven’t used it before but know this is the one you want to use.
We’re using the same data as shown in Figure 1A.6. First, erase
the results of the function in Cell B12 by selecting the cell and hitting the space bar once and then Enter.

e

Inserting a Function Using the Insert Function (fx) Command

1. Select Cell B12.

t,
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2. Click the Formulas tab and the Insert Function command
(fx). When you do this, you will see the Insert Function dialog box as shown in Figure 1A.8. In the Mac version, you see
the Formula Builder dialog box, which does the same thing
as the Insert Function dialog box in the Windows version.
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Figure 1A.8 The Insert Function Dialog Box

A very nice shortcut to the function command (fx) can be found on the
Formula bar just to the left of where you see any information that is entered
into a cell. Just click that, and you get the Insert Function dialog box.
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3. Now you can do one of two things:
a. Type a brief description of what you want to do, such as
average, and click the Go button; or

rib
ut

e

b. Find the function you want in the list of functions and
double-click on it.
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We selected option (b), and when we did, the Function arguments dialog box appeared, as shown in Figure 1A.9. Notice that
Excel automatically assumed that we wanted to average all of the
values above the current cell, and it completed the cell range in the
Number 1 box.

po
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Don’t get too excited. A function’s argument is not really an argument
like a disagreement. An argument in mathematical terms is a set of
premises, and that’s exactly what you need to provide within the
parentheses of any function—a set of premises that the function is to
carry out.
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Figure 1A.9 The Function Arguments Dialog Box

Let’s take a look at the different elements in this dialog box.
•• There’s the name of the function, AVERAGE.
•• Then there are text boxes where you enter the range of cells
(the argument) on which you want the function to perform its
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••

duty. Note that Excel is pretty smart and automatically enters
the range of cells it thinks you want to average. Notice also
that the actual numbers you want to average are listed to the
right of the text box.
In the middle of the dialog box is a description of what the
function does, and above that is the value the function will
return to the cell in which it is located (in this case, your average is 3.3).
The syntax (or directions) of how to put the function together
is given near the bottom, preceded by Number 1.
The formula result is shown again at the bottom left.
Finally, there is a link to a place to get help if you need it.
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4. Click OK, and you will see the same result as you saw in
Figure 1A.7. We entered the function using the Insert
Function command instead of by typing its name, but we got
the same result.

Inserting a Function Using Formulas → More Functions → Statistical

co
py
,
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That really says it all. Just follow these three mouse clicks, and you
will see a list of all the statistical functions that are available.
Selecting any of them (such as AVERAGE) provides you with the
same dialog box you see in Figure 1A.9.
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Most functions can do a lot more than first appears. Excel functions are
so useful because they are so flexible. For example, with the simplest
of functions such as SUM, you can enter the following variations as
arguments and get the following results.

If you enter the
following formula . . .

=SUM(3,4)

Adds the values to get 7.

=SUM(A2:A4)

Adds the values located in Cells A2 through
A4.

=SUM(A2:A4,6)

Adds the values located in Cells A2 through
A4 and also adds the value of 6 to that sum.

=SUM(A6:A8,4)

Adds the values located in Cells A6 to A8 and
adds the value of 4 to that sum.

o
D

Excel does this . . .
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Now you know two ways to insert a function in a worksheet—by typing
its name or selecting it through the Insert Function dialog box. And
once a specific Function Arguments dialog box (like the one you see in
Figure 1A.9) is open, you can just enter the cell addresses in the appropriate text box. However, you can also just click in the cell address box
and then drag the mouse over the cell addresses you want to include
in that box. This is good. But there’s another nifty way to go about this.
), which
You can click on the Collapse button (which looks like this
will shrink the entire dialog box and allow you to select the cells you
want using the mouse directly on the worksheet. Then click the Expand
button, and the dialog box returns to its normal size with the cell
addresses included.

po
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If you insert a function by typing it directly into a cell (or even by typing
a partial name), the 2016 version of Excel provides a list of similarly
spelled functions as well as a tip about how to use your function, as you
see in Figure 1A.10. Here we typed in =aver, and as we typed, Excel
provided a list of various average functions plus a tip as to what the
AVERAGE function does.

no
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Figure 1A.10 Excel Helps You Choose the Right Function
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Using Functions in Formulas
It’s time to get a bit fancy. Now, formulas and functions are basically
the same animal—they carry out instructions. There’s just no reason
why you can’t include a function in a formula.
For example, let’s say that you have three job evaluation scores
(Eval 1, Eval 2, and Eval 3) as you see in Figure 1A.11. You also
have a Fudge Factor (in column E), which is a value you can
use to increase or decrease an employee’s score at your discretion.
For example, you want to increase employee GH’s score by 3%, so
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you multiply the average evaluation score (from Eval 1, Eval 2, and
Eval 3) by 1.03. Figure 1A.11 shows the formula that includes the
AVERAGE function (which you will learn more about in Chapter 2).
Using a Function in a Formula

po
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Figure 1A.11
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As you can see in the formula bar shown in Figure 1A.11, the
formula in Cell F2 looks like this:
=AVERAGE(B2:D2)*E2
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And it reads like this: The contents of Cells B2 through D2 are
averaged, and then that value is multiplied by the contents of Cell
E2. We copied the formula from Cell F2 to Cells F3 through F11,
and the results are shown in Column F.

We’re Taking Names: Naming Ranges

It’s certainly easy enough to enter cell addresses such as A1:A3—not
much work involved there.
But what if you’re dealing with a really large worksheet with hundreds of columns and rows and thousands of cells? Wouldn’t it be
nice if you could just enter a name that represents a certain range of
cells rather than having to remember all those cell addresses? Desire
it no more. Excel allows you to name a range, or a collection of cells.
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For example, in Figure 1A.11, if you want to average the employees’
second evaluations, instead of using the cell addresses C2:C11, why
not just give the range of cells a name, such as eval2 or EVAL_2 (no
spaces, please!)? Then, the average for that set of scores using the
AVERAGE function would look like this—

rather than like this—
=AVERAGE(C2:C11)

rib
ut

=AVERAGE(EVAL_2)
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And if you can believe it, this only gets better—you can just paste
that name into any formula or function with a few clicks. You don’t
even have to type anything!
Here’s how to assign a name to a range of cells:
1. Highlight the range of cells you want to name.

2. Click the Name box at the left end of the formula bar (in the
Mac version, it’s the Define Name option on the Formulas bar).

po
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3. Type the name that you want to use to refer to your selection, as shown in Figure 1A.12 (we used Eval_2). And again,
no spaces please—Excel does not like them in name ranges.
Naming a Selection of Cells as a Range
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Figure 1A.12

4. Press Enter.
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Seeing Range Names

co
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Figure 1A.13

rib
ut

Once a range is defined, you can use the name assigned instead of
a cell range. If you remember that the data are named, you can just
enter that name by using the drop-down menu now available in
the Name Manager command area (on the Formulas tab), as
shown in Figure 1A.13. Or you’ll use the Apply Names option in
the Mac version.

e

Using Ranges
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Let’s use the ranges that were defined and compute the average of
all the Fudge Factor scores.
1. Click on Cell F12, where the average will be placed.
2. Type =average(.
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3. Click Formulas → Use in Formula, and you will see the Use
in Formula drop-down menu, as shown in Figure 1A.14.
4. Click on Final_Score.
5. Type ).
6. Click Enter and take a look at Figure 1A.15, where you can
see how the name was used in the function rather than the
cell addresses of F2 through F11.
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The Menu for Selecting a Range of Cells

Figure 1A.15

Inserting a Cell Range Into a Function
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Figure 1A.14
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Real-World Stats will appear at the end of every chapter and, hopefully, will provide you with a demonstration of how a particular
method, test, idea, or some other aspect of statistics is used in the
everyday work of scientists, physicians, policy makers, government
folks, and others.
In this first such feature, we look at a very short paper in which the
author shares the argument for the National Academy of Sciences
(first chartered in 1863, by the way!) to “whenever called upon by any
department of the Government, investigate, examine, experiment, and
report upon any subject of science or art.” This charter, in turn, led to
the formation of the National Research Council some 50 years later in
1916, another nonprofit that provides policy makers with information
they need to make informed decisions. Often this “information” takes
the form of quantitative data—also referred to as statistics—that assist
people in evaluating alternative approaches to problems with a
wide-ranging impact on the public. So, this article, as does your book
and the class you are taking, points out how important it is to think
clearly and use data to support your arguments.
Want to know more? Go online or go to the library, and look
for . . .

e

REAL-WORLD STATS

co
py
,

Cicerone, R. (2010). The importance of federal statistics for advancing science
and identifying policy options. The ANNALS of the American Academy of
Political and Social Science, 631, 25–27.

SUMMARY

no
t

This may be a “little” chapter, but it contains some of the most useful
tools that Excel has to offer. In fact, the uses of formulas and functions
are limited only by your imagination. As you use Excel, you will find
more and more ways to make these powerful tools work exactly the way
you need them to.
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TIME TO PRACTICE
1. Create formulas for the following in an Excel worksheet:
a. Add the values of 3 and 5 to one another.
b. Subtract the value of 5 from 10 and multiply the outcome
by 7.
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c. Average the values 5, 6, 7, and 8.
d. Find the sum of the squared values of 3, 4, and 5.
2. Use the AVERAGE function to add the values of 3, 5, and 7 and
divide the total by 3.

rib
ut
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3. What would the function look like for summing the values in
Cells A1 through A5?
4. What would the function look like for averaging the values in
Cells A1 through A5?

The Functions You’ll Love to Love*

The Function
Name

What It Does

po
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Table 1A.1
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5. Create a worksheet with any five values in Cells A1 through A5,
name the range of these cells Test_Scores, and enter a function
in Cell A6 that computes the average. Can you think of another
way to do this?

Returns the average of its arguments

2

CHISQ.DIST

Returns the one-tailed probability of the chisquare distribution

17

CHISQ.TEST

Returns the test for independence

17

CORREL

Returns the correlation coefficient between two
data sets

5 and 16

COUNTIF

Counts the number of nonblank cells within a
range given certain criteria

2 and 20

DAVERAGE

Returns the average for a set of entries contained
in a database

20

F.DIST

Returns the F probability distribution

13

F.TEST

Returns the result of an F-test

13

FORECAST

Returns a value along a linear trend

16

FREQUENCY

Returns a frequency distribution as a vertical array

16

GEOMEAN

Returns the geometric mean

2

INTERCEPT

Returns where a regression line crosses the y-axis

16

KURT

Returns the kurtosis of a data set

4
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AVERAGE

o
D

The Chapter in
Which You’ll
Read About It
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The Chapter in
Which You’ll
Read About It

Returns the parameters of a linear trend

16

MEDIAN

Returns the median of the given numbers

2

MODE.MULTI

Returns the most common values in a data set

2

MODE.SNGL

Returns the most common value in a data set

NORM.S.DIST

Returns the standard normal cumulative
distribution

PEARSON

Returns the Pearson product moment correlation
coefficient

QUARTILE.INC

Returns the quartile of a data set

SKEW

Returns the skewness of a distribution

4

SLOPE

Returns the slope of the linear regression line

16

STANDARDIZE

Returns a normalized value

8

STDEV.P

Calculates standard deviation based on the entire
population

3

STDEV.S

Estimates standard deviation based on a sample

3

STEYX

Returns the standard error of the predicted y value
for each x in the regression

16

T.TEST

2
8
5
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T.DIST
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LINEST

2

Returns the Student’s t distribution

11, 12

Returns the probability associated with a Student’s
t-test

11, 12

TREND

Returns values along a linear trend

16

VAR.P

Calculates variance based on the entire
population

3

VAR.S

Estimates variance based on a sample

3

Z.TEST

Returns the probability of a one-tailed z value

10
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The Function
Name

39
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*Some of the names of the functions that appeared in the Excel 2007 and 2010 versions (and earlier) have changed slightly. For example, TTEST became TEST (leaving the general Excel user, of
course, clueless as to why the change occurred).
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1B

All You Need to Know
About Using the
Amazing Data
Analysis Tools

(a ton)
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How much Excel?
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Difficulty Scale J J (a little tough, but
invaluable to stick with)
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WHAT YOU’LL LEARN ABOUT IN THIS CHAPTER
✦✦ What the Data Analysis tools are and what they do
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(Almost) everything you need to know about Excel, you can learn in
Appendix A. But certain Excel procedures are available only if you
have the Data Analysis tools (which used to be called the Data Analysis
Toolpak) installed, and we use those tools in several chapters in this
book. Excel refers to this set of tools as the Data Analysis Tools, but
you will see it on your screen as Data Analysis tools (and same for the
Mac). No worries; the set of tools, no matter its name, does the same
thing. And remember, for the Windows version, the Data Analysis
tools is an Excel add-in—a special set of tools that may not have been
installed when Excel was originally installed.
How do you know if this add-in is installed on the computer you
are using? If the Data Analysis tools item doesn’t appear on the Data
tab (usually at the right-hand side of the Data tab), you need to
install it. Either ask your instructor to have this done on the network level where Excel nay be installed or install it on your own
machine as discussed in Chapter 1. For the Mac version, the
Toolpak is automatically installed.
The Data Analysis tools are easy to use. You just follow the instructions and identify the analysis you want to perform and the data on

40
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which you want it performed, and you’re done. Throughout Statistics
for People . . . , we will show you in detailed steps how this is done.
One more note: As you already know from Table 1A.1, there are
many functions, and some of these have counterparts in the Data
Analysis tools. For example, you can perform a test for the difference between the means of two groups using a function (T.TEST)
or using the Data Analysis tools (using the t-test tool—say that
three times fast). That’s all for the better. You will often have more
than one way to analyze your data—always a nice position to be in.
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A LOOK AT THE DATA ANALYSIS TOOLS

Using the Sampling Tool From the Data Analysis Tools

D

o

no
t

co
py
,

Figure 1B.1

po
s

t,
or
d

For now, let’s just look at some output where we took a random
sample of 5 numbers from a group of 25 numbers. In Figure 1B.1,
you see the data in Column A; the sample of 5 numbers in Column
C; and the Sampling dialog box that we used from the Data Analysis
tools to tell Excel what to sample, how many to sample, and where
to put the results. Much more about this later in the book, but we
thought you’d like to see how this cool set of tools works.
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ANOVA
Correlation
Descriptive Statistics
Histogram
Moving Average
Random Number Generation
Rank and Percentile
Regression
Sampling
t-test
Z-test

e

For our purposes, we will be working with the following Data
Analysis tools (we’ll be working with about three fourths of them—
the others are more advanced than we need). And in the appropriate
chapter (such as Chapter 2), you will learn about particular tools
(such as Descriptive Statistics):

A Comparison of Data Analysis Tools Output for the Windows and
Mac Versions of Excel
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Figure 1B.2
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Now take a look at Figure 1B.2 and you can see a side-by-side
comparison of the Windows and Mac Excel output from using the

Copyright ©2017 by SAGE Publications, Inc.
This work may not be reproduced or distributed in any form or by any means without express written permission of the publisher.

Chapter 1B ♦ Using the Amazing Data Analysis Tools

43

Descriptive Statistics options in the Data Analysis tools. As you can
see, the output is virtually identical. The way each version is used
is virtually identical as well.

rib
ut
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DON’T HAVE IT? (INSTALLATION AGAIN!)
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The Data Analysis tools is an Excel add-in for the Windows version.
An add-in is a program that adds custom commands and features to
Microsoft Office. Microsoft Office is Excel’s mother ship. For the
Mac version, there’s no installation necessary.

t,
or
d

To load the Data Analysis tools into Excel, follow these steps:
1. Click the File Tab and then click Options.

2. Click Add-Ins and then, in the Manage box, select Data Analysis
tools.
3. Click Go.

po
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4. In the Add-Ins dialog box, select the Data Analysis tools check box
and click OK.
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And you are done and ready to make your Excel activities even
that much more productive and fun.
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Rejoice!! And, for Mac Lovers
Who Are New to Version 2016,
Rejoice More!!!
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1C

For Mac Lovers
Who Are Still Using
Version 2011

A MAC ALTERNATIVE TO
THE DATA ANALYSIS TOOLS
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Mac users of Excel need no longer feel like second-rate citizens,
because the 2016 version for the Mac does indeed offer the Data
Analysis tools feature.
However, for those of you who have yet to upgrade to the newest 2016 version for the Mac, StatPlus (officially called StatPlus:
Mac LE) from AnalystSoft is a free Excel add-in that performs
many of the same types of analysis as do the Data Analysis tools.
It is easy to install and easy to use, and it provides a valuable set
of analytic tools. You can download it from http://www.analystsoft
.com/en/products/statplusmacle/. An important note: There is a
StatPlus Pro version that is not free of charge, and you may be
asked to upgrade to that version. There are a good number of more
advanced analytic procedures that you can only do using the Pro
version, so while the free version gives you a good idea of how
StatPlus works, to do everything, you’ll need to upgrade. Ask you
instructor to have your university buy a license for the Pro version
so everyone can access it.
In previous editions of Statistics for People . . . (the Excel version),
we have mentioned this tool, but this is the first time that we go
into any detail about how it is used. And here’s an early peek. In
Figure 1C.1, you can see a set of sample data (10 test scores) and
the results of a descriptive analysis using StatPlus—all on the same
spreadsheet just the way the Data Analysis tools do it. And, of
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course, like any Excel information, it can be manipulated to appear
as you need it—lines or columns deleted, table templates used, font
size and style adjusted, etc.

e

Sample StatPlus Output
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Figure 1C.1
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Getting Started With StatPlus

There are many ways to use StatPlus, but here’s the most direct and
pragmatic:

no
t

1. Open the worksheet of data you want to analyze in Microsoft Excel.
If you have not already created a worksheet of data, then open a
blank worksheet and enter the data you want to analyze.
2. Open StatPlus.
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3. Perform the analysis you want.

Computing Descriptive Statistics

Here’s how we computed the output you see in Figure 1C.1.
1. Open the worksheet containing the Excel data as you see in
Figure 1C.2.
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2. Open StatPlus.
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Figure 1C.2 Sample Excel Data
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3. Click Statistics  Basic Statistics and Tables  Descriptive
Statistics. When you do this, you will see the Descriptive
Statistics dialog box as shown in Figure 1C.3, where you will
define the range that contains the data you want to analyze.
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Figure 1C.3 Defining the Range for Analysis

4. Select the range of data you want to analyze by either selecting
the range in the worksheet (the easiest way), using the Collapse
button, or entering the range using the keyboard. If you have
column headings for the data, be sure to click the Labels in
First Row check box in the Descriptive Statistics Window.
5. Click OK and you’ll see results as shown in Figure 1C.1.
Figure 1C.4 shows the same results after a good deal of
cleanup using various Excel features.
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Figure 1C.4 StatPlus Output After Format Changes

Options and Preferences
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As you can see in Figure 1C.3, there are both Advanced Options and
Preferences buttons in the box where you define the range containing the data to be analyzed.
The Advanced options contain different options for different analytic tools. For the Descriptive Statistics tool, you can select such
options as plotting a histogram, creating a normal curve (nice!), and
defining the range of intervals. Options change with the analytic
tool being used.
The Preferences button reveals preferences that are constant for
all StatPlus analytic tools and allows you to change font design and
size, number of decimal places used, and even how missing data are
handled.

What StatPlus Can Do
Since you’re interested in StatPlus, here’s what’s covered in various
chapters in the book and the corresponding StatPlus analytic tool.
This should help you to figure out what to use when. You’ll need
either the basic version of StatPlus or the Pro version depending
upon the analysis you want to complete.
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Chapter in Statistics for People . . .

StatPlus Analytic Tool
Basic Statistics and Tables g Descriptive
Statistics

Chapter 3. Vive la Différence: Understanding
Variability

Basic Statistics and Tables g Descriptive
Statistics

Chapter 4. A Picture Really Is Worth a
Thousand Words

Basic Statistics and Tables g Histogram

Chapter 5. Ice Cream and Crime: Computing
Correlation Coefficients

Basic Statistics and Tables g Linear
Correlation

Chapter 6. Just the Truth: An Introduction to
Understanding Reliability and Validity

Basic Statistics and Tables g Linear
Correlation

Chapter 8. Are Your Curves Normal?
Probability and Why It Counts
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Chapter 7. Hypotheticals and You: Testing
Your Questions

e

Chapter 2. Computing and Understanding
Averages: Means to an End

Chapter 9. Significantly Significant: What It
Means for You and Me

Basic Statistics and Tables g One
Sample z test for Mean . . .
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Chapter 10. Only the Lonely: The OneSample Z-Test

Comparing Means (T-Test) . . .

Chapter 12. t(ea) for Two (Again): Tests
Between the Means of Related Groups

Comparing Means (T-Test) . . .

Chapter 13. Two Groups Too Many? Try
Analysis of Variance

Analysis of Variance (ANOVA)

Chapter 14. Two Too Many Factors: Factorial
Analysis of Variance—A Brief Introduction

Analysis of Variance (ANOVA)

Chapter 15. Cousins or Just Good Friends?
Testing Relationships and the Significance of
the Correlation Coefficient

Basic Statistics and Tables g Linear
Correlation

Chapter 16. Predicting Who’ll Win the Super
Bowl: Using Linear Regression

Regression g Linear Correlation
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Chapter 11. t(ea) for Two: Tests Between the
Means of Different Groups

Chapter 17. What to Do When You’re Not
Normal: Chi-Square and Some Other
Nonparametric Tests

Nonparametric Statistics g Chi Square
X2 Test
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